GIS Career Awareness Learning Module # 1

The Digital Earth --- A Virtual Globe

e [Estimated Time: 2 hours

e Learning Goal: This module will introduce the concept of a Digital Earth. The
intended goal of all of the module’s learning activities is to demonstrate to
students how useful it would be to spatially represent data and imagery on a
virtual globe. Engaging software such as Google Earth and Geofusion’s
GeoPlayer will be used to meet this learning objective.

e Platforms: PC, Mac, or UNIX.

o Software Tools Required: Google Earth, GeoFusion's GeoPlayer ActiveX plug-
in, Web browser with high-speed Internet Access. Installation instructors for
educators and users are available in the Appendix at the end of this learning
module.

e INSTALLATION: Educators or Lab Administrators may view step-by-step
installation instructions in the Appendix of this learning module.

Note: This Web-based GIS learning module was developed with support from a National Science
Foundation — Advanced Technological Education Program Research Grant (NSF-ATE DUE # 0401990):
“A Scalable Skills Certification Program in Geographic Information Systems (GIS).”

( http://geoinfo.sdsu.edu/hightech )

Section 1 — Google Earth
Part I — The Emergence of Google Earth

In 2004, Keyhole Inc. was acquired by Google. The software is now called Google Earth.
The concept of the Digital Earth was now unveiled to the general public and not just
researchers or governments agencies. The concept was developed for the defense
industry for use in reconnaissance (observing, spying, and planning). The software
enables you to virtually fly over any place in the world from your computer at home,
school, or the library.



Part II — Google Earth Basic User Controls

The following exercises will give you hands on experience with using these software
applications as learning and research tools.

Begin by starting the Google Earth application.
Start Google Earth on your computer by clicking on the Google Earth icon .ﬁ or

performing another similar action. The way you start Google Earth may be based on how
your computer is set up. Ask your teacher or lab personal if you need assistance.
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Figure 1: Google Earth Main Control Panel (Different Color Boxes Used to
Highlight Separate Control Groups)

You are going to learn about Google Earth’s basic features and controls. You will spend
about 10 minutes learning about these tools by quickly completing the following steps.

Toggle on (turn on) some Points of Interest such as “Roads,” “Terrain,” and “Borders” by
clicking on the check boxes next to them (See left side of Figure 1 above). This will
enable you to view these features on the virtual globe when you are zoomed in
sufficiently close.

Go to the “View” pull-down menu and toggle on the “Compass and Overview
Map” by clicking them so they have a check mark next to them. If they are both selected
already, leave them alone.

Go to the “Tools: pull-down menu and toggle on the “Navigation Panel,”
“Places,” “Layers,” and “Search” tools.

Here is a list of some of the basic controls and their functions:

“Pan” L4 allows you to spin and move around the digital globe. Try it by
moving your mouse over the virtual globe and move the globe around by clicking and
dragging the globe in one direction or another. Spend no more than a minute trying this.



NOTE: If you are using a slow Internet connection, you will see that the images may take
some time to update. The “Streaming” indicator on the bottom of your viewing window
indicates what percentage of the current scene has been downloaded.
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“Zoom In” d allows the user to zoom in (get closer) to the ground to see more
detail but in a smaller geographic area. Try Zooming in to around where you live. Spend
no more than a minute doing this. Remember, you may need to give Google Earth some
time to download the “full” image.

A shortcut to zooming in is to double-click on any part of the image. When you double-
click on any part of the image scene, Google Earth will partially zoom in to point you
double clicked. You can repeat this procedure to you get close enough to your feature of
interest.

Another shortcut to zooming in involves using the “plus” key (+) on your keyboard.
When pressing the plus key, Google Earth will zoom in to whatever is currently in the
center of the image scene.
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“Zoom Out” & allows the user to zoom out (go farther away) from the ground to
see less detail but in a greater geographic area. Try quickly Zooming out to till you see
the entire globe.

A shortcut to zooming out involves using the “minus” key (-) on your keyboard. When
pressing the minus key, Google Earth will zoom out from whatever is currently in the
center of the image scene.
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“Rotate Left” Qﬁ‘ allows the user to rotate the virtual globe in a
counterclockwise direction. Quickly try it.

At

(¢ . : .
“Rotate Right” & allows the user to rotate the virtual globe in a clockwise

direction. Quickly try it

“Reset North” ‘*-Q allows the user to reset the rotation of the virtual globe so the
top of the screen points to north. After you have rotated the globe, you may want to reset
the position of the virtual globe so the top points to the north. Quickly do this by
pressing the Reset North button.



“Roam” allows the user to roam around or “fly over” any
geographic area. Roam also works in other directions besides north, south, east, and west
by clicking on, holding, and dragging the red dot in the middle of the control toward the
desired direction. Quickly try all of the controls on the “Roam” control.

In the “List of Layers” menu (left side of Figure 2), be sure that the “terrain” and
“3D Buildings” layers are toggled on. Also “Terrain” and “Buildings” on the “Points of
Interest Controls” (right side of Figure 2) should be selected with a check mark. After
verifying that the “Terrain” and “Buildings” layers are selected in both the “List of
Layers” and “Points of Interest Controls,” you will be ready to use the Tilt control. “Tilt
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| is probably one of the coolest functions in Google Earth. It allows the user to “tilt”
the image scene and see it with a 3-D perspective at different angles! If you have the
“Buildings” and “Terrain” features toggled on in both the “List of Layers” and “Points of
Interest Controls”, you may be able to see 3-D terrain and buildings depending on what
geographic areas you are observing.

Some of the most dramatic examples include the Grand Canyon in Arizona (dramatic
terrain) and downtown Las Vegas (casino and hotel buildings). You can “fly” to these
areas by typing Grand Canyon or Las Vegas in the “Fly To” address field and pressing
enter.
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Figure 3: Flying to the Grand Canyon by Entenng “Grand Canyon” in the Fly To
Address Field

To access the “Fly To” address field (See Figure 3), go to the “Tools” pull-down menu
and toggle the “Search” tool on. Ifiit is already selected then toggle it off then back on
(Turn it off then on again). The “Fly To” address field should show up. After it appears,
type either Las Vegas or Grand Canyon and press enter on your keyboard. Google Earth
should fly to your desired destination.

After you have reached your destination, click on the bottom button of the “Tilt” control

until you see the terrain or building with a 3-D perspective (See Figure 4). After you see
the terrain in 3-D, try exploring the local area by moving around and zooming in and out!
Spend no more than a minute with this activity then move on.

Figure 4: Viewing the Grand Canyon with a 3-D Perspective Using the Tilt Control
and Other Map Navigation Tools

“Add Placemark” ﬁ allows the user to mark a point of interest. You may
find something interesting and want to “bookmark™ it for future reference. We’ll explore
this control later.



Print Screen 5 allows the user to print out an image of the current view

displayed on the screen. You may want to try this control later.
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Email “=55¢ allows the user to send the current view to an email recipient if your

computer is currently set up with email. You may want to try this control later.

Let’s quickly try some of the steps you learned above.

1.

2.

Be sure that Google Earth is running.

The next step is to type the keyword San Diego in the “Fly To” address field (See
Figure 3) and then press the enter key on your keyboard. This will fly you to the
center of the city of San Diego, California.

Now we are going to introduce an important concept in GIS called, “Map layers.”
Map layers are layers of map features, data, or imagery that can be overlaid or
stacked together like layers on a cake or toppings on a burger. Now turn on the
“Roads” and “Buildings” features in the “Points of Interest” controls (right side of
Figure 2) and the “roads” and “3D Buildings” features in the “List of Layers” (left
side of Figure 2).

You can now add more feature layers to Google Earth by clicking on the check
boxes in the List of Layers at the left of the screen (left side of Figure 2). Click
on several. You may want to select “Borders,” “Transportation,” “Geographic
Features,” etc. Even though you have turned on some layers, their associated
features may not be visible until you sufficiently Zoom In or go to the geographic
areas where they occur. This is called “scale-dependent features.” It would not
make sense to show all buildings on the map when you are zoomed out all the
way to the point where you can see the entire planet! In real life, you would not
see all of these features from outer space. Google Earth and other Virtual Earth-
type applications make features like roads, buildings, parks, etc. visible only when
they would be visible in real life.

Now you are free to use the Google Earth navigation tools like “Zoom In,”
“Zoom Out,” “Tilt,” etc. to explore the entire globe. Spend two minutes doing
this.



Part III — Please complete the following exercises and answer the following
questions. You should try to spend no more than 30 minutes doing these exercises:

1.

To locate a unique point on the earth, a coordinate system must be used. Google
Earth and many other applications use the geographic coordinate system of
latitude and longitude.

Latitude: Latitude describes an imaginary survey line which runs east to west.
You can think of these parallels of latitude as forming the rungs on an imaginary
ladder. Latitude, when used in a coordinate, is expressed as an angle from 0 to 90
Degrees either north or south of the equator (See Figure 5).
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Figure 5: Latitude

The most important parallel of latitude is the equator. It surrounds the middle of
the earth like a belt and can be described as 0 Degrees latitude.

In the “Decimal Degrees” system, it is important to note that when you are going
north of the equator the values range from 0 to 90 Degrees and you are going in
the “positive” direction. Think of this as going “up” on the imaginary ladder
starting from the equator. When you go south of the equator, the values range
from 0 to -90 Degrees. Think of this as going “down” the imaginary ladder from
the equator. If you don’t make this distinction, you won’t know if you’re talking
about a north latitude or a south latitude because they both range from 0 to 90
Degrees.

As an example, Sydney, Australia, which is in the Southern Hemisphere, lies at
approximately -33.87 Degrees Latitude (note the negative sign).



As another example, Anchorage, Alaska which lies in the Northern Hemisphere,
lies at approximately 61.22 Degrees Latitude (note that it’s a positive value).

When used on a map, a single latitude value is sort of like the equivalent of a y-
coordinate in the Cartesian coordinate system.

Longitude: Longitude describes an imaginary survey line running south to north.
There are 360 Degrees of longitude and they all converge at the North and South
Poles. Longitude, when used in a coordinate, is expressed as an angle from 0 to
180 Degrees either west or east of the Prime Meridian (See Figure 6).
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Figure 6: Longitude

The most important meridian of longitude is the Prime Meridian. This imaginary
line extends from the South Pole to the North Pole and passes through Greenwich,
England. It can be described as 0 Degrees longitude.

In the “Decimal Degrees” system, it is important to note that when you are going
west of the Prime Meridian, the values range from 0 to -180 Degrees and you are
going in the “negative” direction. When you go east of the Prime Meridian, the
values range from 0 to 180 Degrees. If you don’t make this distinction, you won’t
know if you’re talking about a west longitude or a east longitude because they
both range from 0 to 180 Degrees. At positive OR negative 180 Degrees
longitude, you reach the International Date Line. This imaginary line runs from
the South Pole to the North Pole in the middle of the Pacific Ocean and is on the
opposite side of the earth from the Prime Meridian.

As an example, Sydney, Australia, which is in the Eastern Hemisphere, lies at
approximately 151.21 Degrees Longitude (note that it’s a positive value).



As another example, Anchorage, Alaska which lies in the Western Hemisphere,
lies at approximately -149.89 Degrees Longitude (note the negative sign).

When used on a map, a single longitude value is sort of like the equivalent of an
x-coordinate in the Cartesian coordinate system.

Decimal Degrees: Latitude and longitude are most commonly expressed in
“Degrees, Minutes, and Seconds” or “Decimal Degrees.” Both are equivalent.
However, for the sake of simplicity, you are going to use “Decimal Degrees.”

In order to view map coordinates in decimal degrees, you will have to make a
change. First, select the “Tools” pull-down menu and click on “Options...”.

The Google Earth Options menu should appear (Figure 7). In the Google Earth
Options menu, be sure the View tab is selected and change the “Lat/Lon” option

to “Degrees” (Figure 7). This will change how the coordinates are represented in
Google Earth. In this case, the latitude (y-coordinate) and longitude (x-coordinate)
will be represented in decimal degrees. Save the settings by clicking on the “OK”
button.
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Figure 7: Google Earth Options Menu with Degrees (Circled in Red on the Top)
Selected for Latitude and Longitude in the View Tab (Circled in Green in the
Middle)

Now you are going to determine what the Latitude and Longitude coordinates of
your school are? (Hint: Be sure the “borders” and “roads” features are selected in
the List of Layers; then locate your school; then, find out the latitude and
longitude coordinate values by moving your mouse cursor over the center of your
school in the view window. Coordinates will appear in the bottom-left corner
(See Figure 8 below). Alternatively, you can enter the full address of your school
in the Fly To address field.)



iplay

gy Aatthe
ey BOMOM
Left-side
Comer

|J1
Scane

q-

= 1 - £ 3
Figure 8: Latitude and Longitude Coordinates of Mission Bay High School (San
Diego, CA)

Fill in these answers:

A-1: Your School Name:

A-2: School Latitude (the map Y-coordinate in degrees):

A-3: School Longitude (the map X-coordinate in degrees):

After you determine where your school is located, create a Placemark that marks
the location of your school. To do this you need to follow a few easy steps:

Make sure your school is displayed near the center of your screen.

Next, click in the Create Placemark tool. It looks like a pushpin and is located
near the bottom right of your screen in the control panel (See Figure 9 below).
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Figure 9: Google Earth Control Panel (Add Placemark Tool Circled in Red on the
Right)

A New Placemark control panel should pop-up and a Placemark will appear near
the center of the screen (Indicated by the red arrow in Figure 10 below).
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Figure 10: Creating a Placemark in Google Earth (Mission Bay High School, San
Diego, CA)

At this point, click and drag the Placemark on the map to the center of you school
campus.

Next, type in the name of your school in the Name field of the New Placemark
control panel (Indicated by the green arrow in Figure 10 above). The Placemark
will then, automatically display your school’s name. Before you press the OK
button to finish creating the Placemark, fill in the following information from the
New Placemark control panel:

A-4: Name Which You Entered for the School:
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Click on the “Advanced” checkmark box in the New Placemark menu. Now
select the “Location” tab. You will see the Latitude and Longitude that is

associated with your Placemark (Figure 11).

Google Earth - Mew Placemark

Figure 11: Viewing the Latitude and Longitude Coordinates (Circled in Red on the

Bottom) of a Newly-Created Placemark. (Advanced Menu Selected as Indicated by

Blue Circle on the Top. Location Tab Selected as Indicated by Green Circle in the
Middle.)

Based on the information that you read from the New Placemark menu, fill in the

following:

A-S: Latitude as Shown in the New Placemark control panel:
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A-6: Longitude as Shown in the New Placemark control panel:

After copying this information, click on the OK button to save the new Placemark
of your school on the map. Now, you will notice that when you Zoom Out, the
new Placemark of your school will remain visible.

Now you will determine what is the direct straight line distance between your
school and San Diego State University (SDSU)?

Now, to locate SDSU, simply type the address of the university in the Fly To
address field. (See Figure 3 if you forgot what the Fly To address field looks
like.) The address is near 5398 Campanile Dr., San Diego, CA.

After you locate SDSU, create a new Placemark for SDSU using the same steps
as Question 1 above so that it will be easier to measure the distance.

Now, Zoom out enough so you can see both Placemarks (your school and SDSU).
You should be able to do this even if your school is located in another country!

Now open the Measure Tool control. The Measure Tool is locating in the Tools
pull-down menu. It might also be called Ruler depending on which version of
Google Earth you are using. Use Miles as your measuring unit and create a
straight measuring line between your school Placemark and the SDSU Placemark.
All you have to do single is click on your school and then click on SDSU while
the Measure Tool is open. Now, you have the approximate straight line distance
between your school and SDSU (Figure 12)!
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Answer the following:

A-7: Distance Between Your School and SDSU: miles

Now close the Measure Tool by clicking on the X on the top right-hand corner of
the Measure Tool menu.

In this next step, you will create street map directions between your school and
SDSU.

First, right mouse click (or Mac users, hold down the Control button and mouse
Click) on your newly-created high school Placemark. A pop-up menu should
appear with many options. Select the “Direction from this” option from the pop-
up menu.

Now that you set the origin (the “From”), you need to set the destination (the
“To”). Do this with the same procedures. Right mouse click (or Mac users, hold
down the Control button and mouse click) on the SDSU Placemark which you
created. Select the “Direction to this” option from the pop-up menu.

Now, Google Earth should automatically create the street navigation direction
between your school and SDSU!

If you zoom into your school, you will see street by street instructions all the way
to SDSU!

A-8: Copy down the first driving instruction that Google Earth lists FROM your
school (Just copy down the first one!):

Other questions with Google Earth.

a. “Area 517 is a Top Secret U.S. Military site in the Nevada desert that
many in the government claim does NOT exist! The coordinates are
37.249361,-115.812339. (Don’t forget the negative sign in the longitude.)
Now briefly answer the following question based on what you find. What
is Area 51? (Hint: Copy these coordinates into the Fly To address field.
Be sure the Fly To address field tab is selected!)

A-9: Briefly describe “Area 517

14



b. What is the name of the nearest Pizza restaurant to your school? (Hint:
First, make sure your school is near the center of the screen then, select the
Local Search tab located next to the Fly To tab (Figure 14) and enter Pizza
in the “What” field then press enter.)
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Figure 14: A Local Search of Pizza Restaurants (Local Search Tab Circled in Red
on the top)

A-10: What is the name of the nearest Pizza Restaurant to your school?:

Measure how far it is from your school with the Measure Tool.

A-11: How far is the Pizza Restaurant from your school? (Give the
distance in feet.):

feet

C. Alcatraz Island, near San Francisco, California, used to be used as an
“inescapable” high-security prison where the worst and most notorious
criminals were kept. The island known as “The Rock” is surrounded by
dangerous currents and freezing-cold water. It was supposed to be nearly
impossible to escape!

Use Google Earth to determine which direction the city of San Francisco

is from Alcatraz Island and how far apart they are. (Hint: Use the Fly To
field and type Alcatraz.)
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The idea is to determine how far someone needs to swim in the ice-cold
water to escape the prison island (If you need to know the city names on
the viewer, simply toggle on the layer called, “Populated Places” in the
“List of Layers” (Figure 2 left side). Also, determine what direction the
Golden Gate Bridge is from Alcatraz Island.

A-12: Which direction must you go (North, South, East, West) from
Alcatraz Island to the shores of the city of San Francisco?:

A-13: How far apart is Alcatraz Island from the nearest point along the
shoreline of the city of San Francisco (in feet)?:

feet

A-14: Which direction (North, South, East, West) is the Golden Gate
Bridge from Alcatraz Island?:
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Section 2 - GeoFusion’s GeoPlayer
Part I — A Simple Introduction to GeoFusion’s GeoPlayer

GeoFusion Inc. is a 3-D visualization technology company based in Santa Cruz,
California. Primary markets for GeoFusion are Geographical Information Science
(GIScience), navigation, government, defense, gaming, entertainment, and consumer
products. GeoFusion can be found on the Web at http://www.geofusion.com . Their
company goal is “to put digital earth on everybody’s desktop”. They enable users to
customize their system for a variety of applications.

Some examples implemented on the GeoMatrix Gateway Website at
http://www.geoplayer.com/gateways/ include the before-and-after imagery of the areas
significantly affected by the 2004 Indian Ocean tsunami; and the southeastern U.S. areas
significantly affected by Hurricane Katrina. There are also imagery datasets available that
display the earth in topographic (land heights), night (city lights at night), and
bathymetric (ocean depths) perspectives.

Most of the examples are self explanatory and image-oriented. For instance, the Katrina
imagery at the GeoMatrix Gateway website allows us to compare the raster (or pixel-
based) aerial and/or satellite imagery of New Orleans land areas before and after the
devastating impact of Hurricane Katrina (See Figure 15 below).

Figure 15: Hurricane Impact on New Orleans — Darkened Areas Indicate Flooded
Areas (GeoFusion GeoPlayer: http://www.geoplayer.com/gateways/katrina.html )
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Figure 16: High-Resolution Imagery Using GeoFusion Showing a Major Levee
Break and the Subsequent Flooding at a Location in New Orleans After Hurricane
Katrina

Part II — Using GeoFusion’s GeoPlayer
Now that you have been introduced to Google Earth, it is now time to work with another

Virtual Earth application. While using this next software application, think about how it
is both similar and different from Google Earth.

Figure 17: GeoPlayer’s Main Screen

On the right side of the GeoPlayer user interface, there is a pull-down menu interface
(Figure 18 below) with which you can choose a predefined set of imagery data.
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A layer list along with associated “transparency slider controls” allows users to turn on
and turn off layers and adjust their visibility (Figure 19).

Transparency settings allow you to vary how much you to partially “see through” images.
This might be handy if you want to compare overlapping images to see if they are lined
up correctly or if there are major differences between the images. Transparency settings
are incredibly useful for comparing “before-and-after” images after a major change.
These major changes might be new building construction, natural disasters such as fires,
etc.
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Figure 19: Layer and Slider Controls with the “Earth Bathymetry”(Water Depths)
and “Terrain”(Ground Elevation) Layers Turned On

The “Fly To” pull-down menu (Figure 20 below) allows you to virtually navigate to
specific features related to the imagery dataset that you have chosen. In the case of the
figure below, The “Katrina Impact” imagery dataset was chosen so all images related to it
are displayed in the “Fly To” menu.
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“Katrina Impact” Dataset

The “Find Address” control (Figure 21 below) lets you type in addresses that are located
in the currently-selected images. Note: This means that the address that you are
searching for must be in the current image otherwise; it will not be found.

"Find Address
(ex: 2300 Selma, New Orleans
LA

or: Banks and Scott, New
Orleans, LA)

L Jcol

Figure 21: Find Address Control in GeoFusion’s GeoPlayer

To” Pan or (Move Around) an Image” using GeoFusion’s GeoPlayer, be sure the image
window is active by single-clicking on it with your mouse. Then press and hold down
the left mouse button while dragging the image in the desired direction (See the top part
of Figure 22 below for an example of panning).

To” Zoom-In” or “Zoom-Out “of an image using GeoFusion’s GeoPlayer, be sure the
image window is active by single-clicking on it with your mouse. Then use the mouse’s
scroll wheel to zoom-in or zoom-out. Alternatively, press and hold down the SHIFT key
on your keyboard and click on the left mouse button to zoom in and the right button to
zoom out (See the bottom part of Figure 22 below for an example of zooming-in).

20



Foo0 ool Before Zool ala sls 1L

Figure 22: Examples of Using the Pan and Zoom Functions with GeoFusion’s
GeoPlayer

Part III — Please answer the following questions:

B-1: Name two reasons why federal government agencies, such as the Federal
Emergency Management Agency (FEMA) and private disaster relief agencies, such as
the Red Cross, would be interested in before-and-after images of a major natural disaster
such as Hurricane Katrina:

2.

With only a high-speed Internet connection and software such as GeoFusion’s GeoPlayer,
a person can access a wide variety of image data from computers around the world.

B-2: Name one reason why people who were displaced/evacuated from the areas affected
by Hurricane Katrina might want to use a Digital Earth GIS tool such as GeoFusion’s
GeoPlayer with similar image datasets:
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Part IV — Image Analysis with GeoFusion’s GeoPlayer

In this section, we are going to demonstrate using the GeoPlayer Virtual Earth application
as a GIS image analysis tool. First, we begin by identifying the study area.

Study Area: The study area is the bayou/swamp area that forms a porous boundary
between New Orleans’ Lake Pontchartrain and the Gulf of Mexico. As you can see in the
zoomed-in image caption of Figure 23, the city of New Orleans lies south of Lake
Pontchartrain in the southeastern part of Louisiana (If you describe Louisiana as a “boot,”
New Orleans would near the “toe.”).
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Figure 23: Hurricane Katrina Impact “Study Area”

After zooming in to the “Study Area” (top image of Figure 24 below), we can see the
swamp and man-made structures built around the swamp (bridges, homes, etc.) (center
image of Figure 24 below).

After clicking the check box to turn on the Digital Globe Satellite image, we can quickly
see the same area after Hurricane Katrina’s devastating effects (bottom image of Figure
24 below). Compare the images before and after the effects of Hurricane Katrina. Many
of inundated (flooded) areas are clearly visible.
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Figure 24: Observing Some of Hurricane Katrina’s Effects

In Figure 25 below, we see detailed before-and-after images of parts of the city of New
Orleans. Notice that the darkened areas represent severe inundation (flooding).
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Figure 25: Before-and-After Imagery Demonstrating the Inundation of New
Orleans

New Orleans suffered the most due to the fact that the city is below sea level and water
entered through failed levees causing water from Lake Pontchartrain to enter the city
streets. Levees are natural or man-made “walls” that separate land and water (See Figure
26). If'they fail like they did in New Orleans, flooding of land is possible (See Figure 27).

Figure 26: A Levee Acts as a Barrier Between Land and Water
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Figure 27: High-Resolution Imagery Using GeoFusion Showing a Major Levee
Break and the Subsequent Flooding at a Location in New Orleans After Hurricane
Katrina

Part V — Please complete the following exercises:

Navigate to http://www.geoplayer.com/gateways/index.html .

Choose the Hurricane Katrina Impact example by clicking on it (Figure 28).
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Figure 28: Choosing the Hurricane Katrina Impact Example (Circled in Red in the
Middle)

After the map viewer loads, you will see that the “Earth Bathymetry” and “Terrain”
layers have been enabled by default. You can tell if a layer is enabled if there is a check
mark next to it.

Please zoom into the levee area around New Orleans. As a shortcut, you can fly to “New
Orleans, LA” by selecting it from the “Fly To” pull-down menu (Figure 29).
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Figure 29: Flying to New Orleans, Louisiana

Allow the image to download completely and study the surrounding area by zooming in
really close and panning around (See the instructions above Figure 22 if you forgot how
to pan and zoom.). When you zoom in really close and allow the image to load, you will
be able to see small details such as individual cars.

At this time, toggle on the “Digital Globe Satellite” layer by clicking on the check box
next to it. Again, pan around and zoom closely to the areas around New Orleans---
especially the areas right along to the northern shoreline of Lake Pontchartrain. If you
zoom in close enough and allow the images to load, you will see the devastation up close.
Figure 30 shows the flooding and devastation around the New Orleans Municipal Yacht
Harbor and surrounding residential areas.

Figure 30: Zoomed in to the New Orleans Municipal Harbor Area (Circled in Blue

on the Top-Middle) Where Severe Flooding of a Nearby Residential Area (Circled

in Red on the Bottom) is Clearly Visible When the Digital Globe Satellite Layer is
Toggled On (Circled in Green on the Top-Right)
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You can also use a map layer to determine the name of the area you are viewing by
toggling on the “Map” layer. Click on the check box next to the “Map” layer to turn it on.
(Figure 31). If you are unable to clearly read the map, zoom in or out until you can read
the text clearly. Notice that you can now identify the names of the areas that are visible

in Figure 30 above. You can use this “Map” layer at any time by Toggling on and off as
you view different parts of the map. Please note that, like other layers, only specific

areas are covered by the layers available. Ifthere is no layer coverage, you may notice
that nothing seems to change when you toggle a layer on and off.
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Figure 31: The Same View Area as Figure 30 w1th the Map Layer (Circled in Red
on the Top-Right) Toggled On

You can also search by specific address or intersection. As an example, in the “Find
Address” text field area (Figure 32), enter the following intersection and then press the
“Go” button: Academy and Bellaire, New Orleans, LLA. This will fly you to the area
around Highways 10 and 610 which were completely submerged. You will also be able
to see abandoned vehicles on the highway.
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~ind Address

(erc 2300 Selma, New Ordeans, LA
or; Banks and Scott, Mew Oreans, LA)
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Crelitg
Katnina GIS Team

Hasting: SDSUf SDSC

Terms of Use

Figure 32: Using the Find Address Text Input Field to Fly to the Intersection at
Academy and Bellaire, New Orleans, LA.

Another interesting layer is the “Earth Bathymetry” layer. This layer lets you visualize
the depths of the oceans. Go ahead and turn on the “Earth Bathymetry” layer and slide
the “Earth Bathymetry” layer’s visibility slider control all the way to 1.0 (which means
“100% visible). Now use the “Fly To” pull-down menu to fly to the “Katrina Impact

Area.” After the image loads, you should be able to see the boundary of the underwater

continental shelf in this part of North America. This is where the water gets extremely
deep very quickly (Figure 33).

Figure 33: Earth Bathymetry Layer Toggled On and Set to 100% Visible (Circled in
Red on the Top-Right); Flown To Katrina Impact Area (Circled in Blue on the

Center-Right) with the Drop-Off Boundaries of the Underwater Continental Shelf
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Visible (White Arrows on the Bottom) (Additionally, Katrina New Orleans and
Lake Pontchartrain are circled in Green on the Center-Left).

You can also explore other powerful and cool features of GeoFusion’s GeoPlayer by
clicking on the “Help” button at the bottom-right of the purple control panel on the right.
This will cause a list of all of the keyboard controls to appear. Go ahead and click on the
“Help” button and try out some of the displayed control shortcuts. Spend a few minutes
trying them.

If you wish, feel free to explore other built in image sets in GeoFusion’s GeoPlayer.

Figure 34: Other Image Sets Such as Baghdad, Iraq Are Available to View in
GeoFusion’s GeoPlayer

Part VI: Please Answer the Following Questions for GeoFusion’s GeoPlayer:

1. Fly to and zoom in to the “Katrina Impact Area,” turn on the “Digital Globe
Satellite” layer, and find an area affected by Hurricane Katrina that was not
mentioned in the previous exercises. Toggle on the “Map” layer and identify the
area using street and place names. Based on what you find, answer the following
questions (Remember, not all areas have map layers associated with them. You
need to make sure that are viewing areas with Katrina imagery available.):

B-3: Name the area you are describing (You can use the place name, street names,
park names, etc. that are given in the “Map” layer):

B-4: What kinds of devastation/changes are visible at your selected area? (You
may also toggle the “Digital Globe Satellite” layer on and off to see the changes.):
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2.

B-5: Briefly state how a disaster relief agency or government employee might use
GeoFusion’s GeoPlayer imagery of New Orleans to assist New Orleans and its residents.

30



Section 3 — Written Assignment

Now that you have seen and worked with examples of digital globe applications, we
would like you to answer some questions with the idea that you will be putting them
all together in a 250-word paragraph (approximately one typed page) by including
the following information.

C-1:

C-3:

C-4:

In your paragraph, quickly describe (in two sentences or less) each of the two GIS
applications that you used (Google Earth and GeoFusion’s GeoPlayer). Also
describe a couple similarities and a couple of differences between the two.

In your paragraph, also answer if you think that the two GIS applications (Google
Earth and GeoFusion’s GeoPlayer) can help people? It what ways can they help
people? In what kinds of occupations/industries would they be useful?

Now, based on your experience with both GIS applications, pick your favorite. In
your paragraph, please discuss which application you liked the best (Google Earth
or GeoFusion’s GeoPlayer) and tell us WHY? Please also discuss what the best
or “coolest” feature of your favorite application was.

Finally, in your paragraph, describe your experience with using your favorite
application. Was it “fast?” Did it take forever to load images? Did it “work” the
entire time you used it? Did you have any kind of difficulty using it? Based on
your experience with it, would you use it again? Answer why or why not and
how this might affect people who use it in a job.
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C-3:
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STUDENTS MAY STOP HERE!
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Appendix: Installation Instructions

Installation Instructions for Google Earth

These simple instructions have been written using screen shots and instructions for the
Windows Operating System. Installation instructions for the Mac and Linux Operating
Systems are similar.

Be sure to have “administrative” privileges on the computer you are installing the
software on. Accounts on computers in a lab setting usually limit installation to users
with administrative privileges only.

1. Open your Web browser and navigate to URL: http:/earth.google.com/

2. Select Downloads on the left side of the Webpage (Figure A).
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Figure A : http://earth.google.com (Red arrow indicates location of “Downloads”

link)

On the next Web page that is displayed, select “Google Earth” from the available choices.
This is the free version.

On the next Web page, be sure to select the download displayed under the “Version 3”
heading (Figure B). This learning activity has been authored with the currently stable

version of Google Earth as of its writing date and that is “Version 3.”

Select your Operating System before clicking on the “Download Google Earth” button
under “Version 3.
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Figure B: Downloading the Correct Version of Google Earth (Version 3)

After specifying the correct operating system, click on the “Download Google Earth”
button.

After you have clicked on the “Download Google Earth” button, specify where you want
to save the installation file on your computer and keep the original file name.

Thanks, The Google Earth dewnload should stan autematically. ‘3
Wit doetnl, pleass chik hade 1o sl i
Figure C: Part of What is Displayed on the Web Page after Pressing the “Download
Google Earth” Button

NOTE: Web browsers with pop-up or download blocking may get an error message. If
this is the case, click on the “click here to start it” link displayed on the download page to
manually initiate a download (Figure C).

5. After saving the installation file to your computer, close your Web browser and
run the installation file by clicking on it.

6. Follow the Google Earth installation instructions that follow and accept the
licensing agreement and any other installation messages that appear. The default
“Complete” installation is sufficient for the learning module.

WINDOWS USERS NOTE: If you are given an option to “switch to
‘DirectX’mode,” we recommend that you respond by clicking “No” and keep
Google Earth in ‘OpenGL Software Emulation’ mode since it is compatible with a
greater number of computer graphics cards.

Platform Requirements

Below in a table are the System configurations required for PC, Mac and Linux Systems.
Minimum configuration requirement is given below which a minimal features or
component setting that are required to install and run Google Earth successfully on your
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system. With the minimum configuration, you will be able to use the software but
performance (speed) will be limited. Linux installation requires Google Earth Version 4

(Beta version)

PC System Configuration
Minimum configuration for PC:

Operating System: Windows
2000 or Windows XP

CPU: Pentium 3, 500Mhz

System Memory (RAM): 128MB

Hard Disk: 400MB free space

Network Speed: 128 Kbits/sec

Graphics Card: 3D-capable with
16MB of VRAM

Screen: 1024x768, "16-bit High
Color"

Mac System Configuration
Minimum configuration for Mac:

Operating System: Mac OS X
10.3.9

CPU: G3 500Mhz

System Memory (RAM): 256MB

Hard Disk: 400MB free space

Network Speed: 128 Kbits/sec

Graphics Card: 3D-capable with
16MB of VRAM

Screen: 1024x768, "Thousands of
Colors"

Recommended configuration for PC:

Operating System: Windows XP

CPU: Pentium 4 2.4GHz+ or
AMD 2400xp+

System Memory (RAM): 512MB

Hard Disk: 2GB free space

Network Speed: 768 Kbits/sec

Graphics Card: 3D-capable with
32MB of VRAM

Screen: 1280x1024, "32-bit True
Color"

Recommended configuration for Mac:

Operating System: Mac OS X 10.4.5

CPU: G4 1.2Ghz

System Memory (RAM): 512MB

Hard Disk: 2GB free space

Network Speed: 768 Kbits/sec

Graphics Card: 3D-capable with
32MB of VRAM

Screen: 1280x1024, "Millions of
Colors"

Linux System Configuration (for Google Earth Version 4 only)

Minimum configuration

Kernel: 2.4 or later

glibc: 2.3.2 w/ NPTL or later

XFree86-4.0 or x.org R6.7 or
later
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Recommended configuration

Kernel 2.6 or later

glibc 2.3.5 w/ NPTL or later
x.org R6.7 or later

System Memory (RAM): 512MB



CPU: Pentium 3, 500Mhz
System Memory (RAM): 128MB
Hard Disk: 400MB free space
Network Speed: 128 Kbits/sec
Screen: 1024x768, 16 bit color
Tested and works on the
following OSs:

Ubuntu 5.10

Suse 10.1

Fedora Core 5

Linspire 5.1

Gentoo 2006.0

Debian 3.1

Red Hat 9

Hard Disk: 2GB free space

Network Speed: 768 Kbits/sec

Graphics Card: 3D-capable with
32MB of VRAM

Screen: 1280x1024, 32 bit color

Installation Instructions for GeoFusion

The GeoFusion software requires the use of Microsoft Internet Explorer on a Windows
Operating System. It will not work on the Mac or Linux Operating Systems. We

apologize for this inconvenience.

1. Before installing, start Internet Explorer and choose the following sequence of
pull-down menus in Internet Explorer: TOOLS > INTERNET OPTIONS >

SECURITY > CUSTOM LEVEL

You will need to select either “enable” or “prompt” permissions for all Security
Settings related to ActiveX in Internet Explorer. In the screen shot below (Figure
D), everything under “ActiveX controls and plug-ins” must have either “enable”
or “prompt” selected. If this is not already the case, change the permissions and

click “OK” to save them.
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Figure D: Cﬁecking/Changing Internet Explorer Secﬁrity Settings
Then close the Internet Options menu by pressing “OK” again.

Now, Navigate to the following Web URL with Microsoft Internet Explorer:
http://www.geoplayer.com/gateways/index.html

The first time you access the Web page, it will automatically prompt you to allow
installation of the GeoPlayer plug-in software. This software, once installed, will
allow you to use GeoFusion’s GeoPlayer with Internet Explorer and a live
Internet connection.

Follow a GeoMatrix link and the GeoPlayer plug-in will automatically install
when you visit the GeoMatrix Website for the first time only. Be sure to answer
“YES” to the installation questions when prompted.

If you see the below text on your browser (Figure E), make sure you are running
Microsoft Internet Explorer on a Windows PC. If you see an information bar on
top of the page, please choose the option to either install ActiveX control or allow
blocked content.
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Il you see this texl, then your browser is cither blacking ActiveX controb or il is not handling them GeoPlayer
properly. The carrent GeoFPlaver reqaires Microsoft Internet E an a Windows PC platform. 1T o
you s¢¢ an information bar on top of this page, please choose op o cither install ActiveX control or |pe
allow blocked content,

Figure E: Incompatible Operating System and/or Web Browser Used to Access

GeoFusion’s GeoPlayer on the Web

After installation, the globe will be loaded and you are free to explore and the
activities describe in this learning module.

Periodic Updates:

If the imagery and tools on GeoPlayer have been updated, you will be prompted
to install a new version. Simply choose the "Default Installation."

GeoFusion’s GeoPlayer Platform Requirements

The paragraph below is the System configuration for PC Systems. The GeoPlayer
software application is not currently capable of running on Mac and Linux platforms.

Minimum requirements are given below with the minimal feature and component settings
that are required to install the Active X plug-in (the GeoPlayer software application).

*

Microsoft Internet Explorer on a Windows PC platform

Game-level graphics hardware. A list of supported graphics cards is available
at the following Web URL: http://www.geofusion.com/graphics_support.html

This ActiveX control requires either enable or prompt permissions for all ActiveX
browser Security Settings. See instructions given previously.

A faster Internet connection (DSL, Cable Modem, Ethernet, or better)
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